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appendix 
b

Dreamweaver CS5.5, 
Menu by Menu

Dreamweaver CS5.5: The Missing Manual is quite complete; in its pages, you’ll 
find descriptions of every major Dreamweaver function (and most minor 
ones). In the interests of completeness, however, here’s a quick reference to 

every command in every menu—and the answer to the occasional “What does that 
mean?” mystery.

File Menu
The commands in the File menu include basic functions like saving and quitting 
files, and controlling an open Dreamweaver document.

•	 New. Opens the New Document window, which lets you create a new, blank 
Dreamweaver document using any of several types of web document, from ba-
sic HTML pages to dynamic pages like ASP or PHP files. If you create Dream-
weaver page templates, they show up here, too.

•	 Open. Opens the standard Open File dialog box so you can navigate to and 
open an existing Dreamweaver document. You can set the Show pop-up menu 
to display only specific types of documents—only HTML pages or style sheets, 
for example.

•	 Browse in Bridge. Bridge is Adobe’s own file manager. It’s like Windows Ex-
plorer or the Mac’s Finder function. Bridge lets you browse, find, and open 
documents. But since Dreamweaver sports the very useful Files panel (page xx), 
you already have a way to manage your site files. In addition, Bridge is part of 
Adobe’s graphics heritage, so it works best with image files—in other words, 
Photoshop and Illustrator files, not Dreamweaver documents.
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•	 Open Recent. Displays a submenu that lists the 10 most recently opened docu-
ments. Selecting a document from the list opens it. The last option in this menu, 
“Reopen Documents on Startup,” is kind of cool. If you quit Dreamweaver with 
documents still open and have this option checked, Dreamweaver automatically 
reopens those documents the next time you launch the program.

•	 Open in Frame. Opens an existing HTML page within one frame of a frame-
set. To make this command available, you must have a frameset open and have 
clicked inside one of its frames to select the frame—you can’t open an HTML 
page just by loading a Frameset document. The Select HTML file dialog box 
opens and lets you navigate to the file you want to insert into the frame. You can 
also choose to make the file’s URL relative to the document or the root folder, 
as described in Chapter 5. (Frames are an old technology, however. Professional 
designers no longer use them. See the warning about frames in the box on page 
xx)

•	 Close. Closes the currently open Dreamweaver document. If you have unsaved 
changes, Dreamweaver gives you the opportunity to save them.

•	 Close All. Closes all the currently open documents. If you have unsaved chang-
es in any of them, Dreamweaver gives you the opportunity to save them.

•	 Share My Screen. This option works with Adobe’s ConnectNow Web confer-
encing service. You can share your Dreamweaver screen with students, col-
leagues, or your aunt who’s learning how to create websites. The service lets you 
provide real-time demonstrations of Dreamweaver in action. It’s free for up to 
two people. Learn more about ConnectNow at http://www.adobe.com/products/
adobeconnect.html.

•	 Save (Save Frameset/Save Frame). Saves any changes you made to your docu-
ment. Dreamweaver dims the Save command if you haven’t made any changes 
to the document since the last time you saved it.

•	 Save As (Save Frameset As/Save Frame As). This command works slightly dif-
ferently than in other programs. Like most other programs, it saves a copy of the 
current document under a new name, but it also leaves the original document 
and reverts that file to its last saved state. In other words, only the Save As copy 
has the most recent changes you made to the original file…weird.

•	 Save All. Saves changes to all your open documents, including files like external 
CSS and JavaScript files listed in the Related Files bar (see “Related Files” on 
page xx). This is a great command to make sure you save all your changes to 
every document you edited since opening Dreamweaver.

•	 Save All Related Files. Saves changes to the document you’re currently editing, 
as well as files that the current document uses, such as external CSS and JavaS-
cript files, and server-side programs such as PHP includes. This is a good way 
to make sure you save every edit that affects the current file, whether you made 
the change in a CSS file, the HTML source code, or an external JavaScript file.
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•	 Save as Template. Saves the current document as a Dreamweaver template with 
the suffix .dwt. The “Save as Template” dialog box appears so you can specify 
the template’s file name, and indicate which site it belongs to. Dreamweaver 
automatically saves all template documents in a Templates folder in the selected 
site’s folder. You’ll find templates discussed in Chapter 21.

•	 Revert. Undoes any changes you made to a document since the last time you 
saved it. Edit➝Undo is often a better choice; it takes a few more steps to undo 
all the changes you made, but it can actually undo changes past your last save. 
So if you’re one of those gotta-save-it-every-5-seconds types, the Undo com-
mand is for you.

•	 Page Setup. Lets you set up printer settings (like the size paper you want to 
print on) for the Print Code command listed next.

•	 Print Code. Prints the code (that is, what you see in Code view) of the current 
document.

•	 Import. Lets you import data from other sources into your Dreamweaver docu-
ment. For example, you can import XML data into a template or tabular data 
from a CSV (comma separated value) file into an HTML file. Windows users 
can also choose to import text from a Microsoft Word document or tabular data 
from an Excel spreadsheet.

•	 Export. Extracts tabular data or template data as XML from your Dreamweaver 
document, for use in other applications.

•	 Convert. Converts older HTML pages into a variety of more modern formats, 
like HTML 4.01 Strict, two forms of XHTML, or HTML5. Unfortunately, it’s 
kind of hit-or-miss: this feature can’t always update older files to modern stan-
dards.

•	 Preview in Browser. Opens the current document in your web browser. By 
selecting Edit Browser List, you can add new browsers to, or delete browsers 
from, your browser list, or specify a preferred browser. This command also in-
cludes an option to preview your page in a program called Device Central, an 
Adobe feature meant to let web designers preview a web page in mobile devices. 
It works well if you’re working on a Flash movie, but it’s not so good for regular 
web pages. Dreamweaver CS5.5 also lets you preview pages in “Adobe Browser-
Lab”—this option, described on page xx, lets you take screenshots of the current 
page in different browsers using an online Adobe service.

•	 Multiscreen Preview. Opens a window that displays the current web page in 
three different “viewports.” It’s intended to help you work with Media Queries 
(Chapter 12) to preview how a page looks in different devices, like smartphones, 
tablets, and desktop browsers. See page xx for more.

book.indb   1131 6/6/11   5:18 PMwww.itbook.store/books/9781449397975

https://itbook.store/books/9781449397975


1132 dreamweaver cs5.5: the missing manual

Edit MenuEdit Menu

•	 Check Page. Checks the current page for a variety of problems, such as broken 
links, code that’s incompatible with various browsers, and spelling. You can also 
access the link checker and browser compatibility tools from the Results panel 
to check an entire site’s worth of files—choose Window➝Results, and then click 
an appropriate tab, like Link Checker to check links.

•	 Validate. Lets you check XML files to make sure they conform to XML stan-
dards and document type definitions (see page xx). In other words, it checks to 
make sure your XML is correct. In addition, you can check an HTML file using 
the W3C’s online validator—from right within Dreamweaver. Select the “Validate 
current document” option and Dreamweaver connects to the Web, contacts the 
W3C validator, and checks your page’s HTML. If it finds errors, it lists them in the 
W3C validation pane below the Property inspector. If you’re working on a server-
side page (like a WordPress page), then choose the Validate Live Document op-
tion: this first processes a page through a web server and then contacts the W3C 
site. This way, you’re actually checking the finished HTML (after the server has 
completed all its server-side antics and produced a real HTML file).

•	 Compare with Remote/Compare with Testing. Lets you use a third-party 
code-comparison tool to see how the local copy of a page differs from either the 
remote copy (the one on your web server) or the copy on your testing server. 
This identifies all code differences between the two copies. You can learn more 
about this feature on page xx.

•	 Design Notes. Opens the Design Notes window (Chapter 19), where you can 
add additional information about an open document, set its status, and choose 
to have the Design Note appear whenever you open the document.

Note: To use Design Notes, you must make sure that you select the Maintain Design Notes option in the 
Site Definition window’s “Design notes” section.

•	 Exit/Quit. Exits Dreamweaver. If any of your open Dreamweaver documents 
have unsaved changes, the program prompts you to save them before quitting. 
(Mac users will find this option under the Dreamweaver menu.)

Edit Menu
The Edit menu invokes common document changes, like copying and pasting:

•	 Undo. Undoes the most recent change you made to your document. You can 
choose this command repeatedly to step progressively backwards through your 
changes, even after you save the document.

•	 Redo (Repeat). Restores whatever changes you just made by using the Undo 
command. Selecting Redo multiple times moves you progressively forward 
through changes you undid. If you just used a command other than Undo, Re-
peat appears instead of Redo. This property lets you repeat the last action. For 
example, if you just pressed Delete, the Repeat command presses it again.
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•	 Cut. Deletes the selected text or objects from a document, and copies them 
to the invisible Windows or Macintosh Clipboard so you can paste them else-
where. (The Clipboard holds only one selection at a time.)

•	 Copy. Copies the selected text or object to the Clipboard so you can paste it 
elsewhere—without disturbing the original.

•	 Paste. Places the most recent selection from the Clipboard into your document 
at the insertion point.

•	 Paste Special. Opens the Paste Special window, which lets you choose how to 
paste the Clipboard item into your document. Options range from Text Only 
for just plain text to increasingly more elaborate options, which force Dream-
weaver to attempt to preserve various levels of formatting, such as styles, bold, 
italic, bulleted lists, and so on. See page xx.

•	 Clear. Deletes the selected text or objects from a document without placing it 
on the Clipboard.

•	 Select All. Selects everything in the document so you can make document-wide 
changes in one fell swoop. If you have the cursor inside a table cell or <div> tag, 
however, Select All selects just the contents of that cell or div.

•	 Select Parent Tag. Broadens the current selection to include everything within 
its parent tag, including the content. For example, if you have a table cell se-
lected, this command increases the selection to include the entire table row. 
Choose the command a second time and you increase the selection to include 
the entire table. In short, this command ensures that any changes you make ap-
ply to the entire tag.

•	 Select Child. Narrows the current selection to include everything within the 
child tag, including its contents. If you select a table row, choosing this com-
mand decreases that selection to include only the first table cell and its contents.

•	 Find and Replace. Lets you search a document—or an entire site—for a specific 
word, tag, or piece of source code, and replace it with something different (see 
page xx). This command lets you make these changes either en masse or one 
instance at a time.

•	 Find Selection. This command lets you find another instance of the current 
selection. Say you select the word “mothball” on a page. With this command, 
you search the page for another example of “mothball.”

•	 Find Again. Uses the most recent search setting from the “Find and Replace” 
window to search the current document, highlighting the next instance of the 
search item.

•	 Go to Line. Opens the Go To Line dialog box. Type in a number, and Dream-
weaver positions the cursor at the beginning of the specified line of code (avail-
able only in Code view).
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•	 Show Code Hints. Immediately displays any code hints (overriding the delay 
set in the Preferences window) available for the current tag. Code Hints, de-
scribed in Chapter 11, provide a pop-up menu of tag properties appropriate for 
the current tag (available only in Code view, and only when you use the Insert 
Tag command [Ctrl-T]).

•	 Refresh Code Hints. Doesn’t seem to do much of anything.

•	 Code Hint Tools. When you work in Code view, this command lets you access 
Dreamweaver’s color picker, “Browse for File” button, and list of fonts so you 
don’t have to type in things like #FF6633, ../../images/dog.gif, or Arial, Helvetica, 
sans-serif, every time you use a color, link to a file, or want to use a font. In ad-
dition, you can display a pop-up menu of all of the ID, class, and element names 
on a page, which you’ll find useful for JavaScript programming.

•	 Indent Code. Adds one indent before the selected line of code (available only 
in Code view.)

•	 Outdent Code. Removes one indent from the selected line of code (available 
only in Code view).

•	 Balance Braces. When you edit a script in Code view, this command helps you 
check for unbalanced braces (that is, an introductory “{” without a closing “}”) 
by highlighting the matching tags enclosing the selected code. It doesn’t do 
anything for plain HTML, but if you’re writing a JavaScript program or using 
a dynamic programming language like PHP or ASP, it helps identify missing 
braces—a common source of programming errors. Works with opening and 
closing parentheses, and brackets ([ and ]) as well.

•	 Repeating Entries. Lets you cut, copy, paste, and delete repeating regions in 
templates. You can learn about repeating regions in Chapter 21.

•	 Code collapse. Hides a selection of code in Code view so you see only the code 
you want to work on. You’ll find this feature discussed on page xx, and since the 
same options are available more directly from the coding toolbar, you can skip 
this command.

•	 Edit with External Editor. If you haven’t already specified an external HTML 
code editor, such as BBEdit or Notepad, this command opens the Preferences 
window and selects the File Types/Editors category so you can find and select a 
text editor on your hard drive. Once you specify an editor, this command opens 
the current document in that editor. You can change the editor setting from the 
Edit➝Preferences (Dreamweaver➝Preferences) window.

•	 Tag Libraries. Lets you modify the way Dreamweaver writes code for various 
types of tags, such as those for HTML, JavaScript, ColdFusion, ASP, and so on. 
You can create new tag libraries for other types of tag-based languages, or mod-
ify the ones that ship with Dreamweaver.
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•	 Keyboard Shortcuts. Opens the Keyboard Shortcuts window, and shows you 
all of Dreamweaver’s current keyboard shortcuts. You can create a new set of 
shortcuts for specific sites or programs, or export the settings to HTML to share 
your settings with others. (You must duplicate the factory settings before you 
add or delete your own shortcuts, however.) You’ll find details in Chapter 23. 
(On the Mac, this option appears under the Dreamweaver menu.)

•	 Preferences. Opens the Preference window, which is full of options that cus-
tomize the way Dreamweaver works. You can choose from 19 categories of 
preferences, including those that let you edit the color and format of different 
HTML tags, create shorthand versions of CSS styles, and change the order in 
which Dreamweaver’s info panels appear on-screen. (On the Mac, this option 
appears under the Dreamweaver menu.)

View Menu
The View menu controls the document window’s appearance. A checkmark in the 
menu lets you know which view you’re in:

•	 Code. Displays the file’s source code.

•	 Split Code.  Displays the file’s source code in split view, side by side. You can 
use this feature to edit both the HTML near the top of the page (on one side of 
the document window), and HTML elsewhere on the page (on the other side 
of the Document window.) But it’s most useful when you use it in conjunction 
with Dreamweaver’s Related Files feature (page xx). In Split Code view, you can 
view the HTML of the page in one pane, and the CSS of an external CSS file in 
the other.

•	 Design. Displays the file’s visual design.

•	 Code and Design. Splits the document window into two panes: source code on 
the left (or top), visual design on the right (or bottom). You can adjust where the 
split panes appear (see page xx), and adjust how much of each pane you see by 
dragging the center divider left or right or up or down.

•	 Split Vertically. When you’re in Code and Design view, you see the page’s code 
and its design side by side…great for really wide monitors. Unselecting this op-
tion displays the Code and Design views one on top of the other—unless you 
have an unusually tall monitor, this option doesn’t let you see much of either.

•	 Design View on Left/Top. When you’re in Code and Design view, this option 
dictates where Dreamweaver puts the Design view pane relative to the Code 
view pane. If you select Split Vertically, you can display the Design view either 
to the right or the left of the Code view; when you stack Code and Design views 
on top of each other, you can place the Design view either above or below the 
Code view.

•	 Switch Views. Switches between Code and Design views.
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•	 Refresh Design View. Updates the Design view to reflect changes you make di-
rectly to the source code in either Code view or Split (“Code and Design”) view.

•	 Refresh Styles. Who knows? You can only select it when viewing a page in Live 
View, and even then it doesn’t seem to do anything.

•	 Live View. Displays a web page as it would appear in a web browser (actually, as 
it would appear in Apple’s Safari or Google’s Chrome browser). You can preview 
JavaScript, Flash movies, and other interactive page features in this view.

•	 Live View Options. Lets you control the display of Live View. You can pause 
JavaScript—a useful way to see the HTML that JavaScript creates on the fly—
disable JavaScript, turn off plug-ins, and control settings that affect how Dream-
weaver displays the page in Live View (see page xx for more on these options).

•	 Live View Browser. Dreamweaver CS5.5 includes the ability to navigate while 
you’re in Live View. Click a link on a page in Live View and it takes you to 
another page (but only if you turned on that feature in the Live View Options 
menu). The Live View Browser lets you control the navigation just as you would 
in a web browser (page backward or forward, for example), view recent pages, 
and open the currently visited page in a new tab so you can edit it.

•	 Live Code. In Live View, choose this option to display the HTML as it appears 
to a web browser—this is only useful for pages that include JavaScript that can 
dynamically change the HTML of a page by adding classes to tags and even in-
serting or removing entire chunks of HTML. This feature is a good way to make 
sure the JavaScript code you write does what you want it to do to the HTML of 
a page.

•	 Inspect. This option lets you inspect the CSS of page elements in Live View. 
Discussed on page xx, this feature is a great way to inspect CSS in dynamically 
generated server-side pages (such as PHP pages), which you often can’t see in 
Design View.

•	 Head Content. Opens a new menu bar in the main document window that con-
tains shortcuts to the head section of an HTML page. You can use these menu 
items to highlight your document’s title tags, meta tags, and scripts, and then, in 
the Property inspector, edit their content.

•	 Noscript Content. When you insert JavaScript code into the document win-
dow, you can include what’re called <noscript> tags—information that appears 
in browsers that don’t understand JavaScript (of which there are few), or which 
have their JavaScript turned off. After selecting this option, all the information 
inside <noscript> tags appears in the document window. To hide this informa-
tion, select this menu option again.

•	 Table Mode. Lets you switch between the standard Table view, Expanded Tables 
view, and something called Layout Table view. Layout Table view is a holdover 
from earlier versions of Dreamweaver designed to make creating table-based 
layouts easier, but more often creating hard-to-edit HTML. Layout Table view 
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used to appear front and center in the program, but the Adobe engineers have 
hidden it away in this menu, so that those who used the tool in the past can 
continue to use it. But don’t be tempted to! CSS is a far superior way to lay out 
web pages (see Chapter 9 for the details).

•	 Visual Aids. Lets you summon onscreen symbols that represent typically invis-
ible page elements, like image maps, anchors, and the borders of a <div> tag.

•	 Style Rendering. Lets you hide or show the effects of all style sheets on a page, 
or selectively display the formatting changes a style sheet applies to a particular 
type of media—screens only, for example, or printers only.

•	 Code View Options. Lets you adjust the way your HTML appears in Code view. 
You can turn on (or off) options that wrap lines of text to fit in the document 
window, add line numbers, highlight invalid HTML, turn on syntax coloring, 
and indent lines of code.

•	 Window Size. Let’s you change the size of the page that Dreamweaver displays 
in the document window. Best used in conjunction with Media Queries (Chap-
ter 12) to see how a page looks on different-size screens, such as the 320 pixel 
×480 pixel screen of an iPhone.

•	 Magnification. Lets you zoom in, zoom out, and generally magnify your view 
of the document window. It has no effect on the HTML code or how a page will 
display in a web browser, it merely zooms in to get a close-up view or zooms out 
to get a bird’s eye view of the page.

•	 Rulers. When you choose Show, Dreamweaver displays rulers along the top and 
left sides of the document window. Using the options you find here, you can 
choose your ruler units: pixels, inches, or centimeters. You can also reset the 
orientation of the two rulers so that both start from zero in the screen’s upper-
left corner.

•	 Grid. Places a grid of vertical and horizontal lines over the document window 
to use as a guide as you build your layouts. Selecting Edit Grid opens the Grid 
Setting dialog box, where you can adjust the grid’s colors, spacing, behaviors, 
and line appearance.

•	 Guides. Shows, hides, locks, and erases guidelines you drag from a ruler onto 
the current page. Also controls options for guides, and displays guidelines that 
mark the visible area of a browser window for monitors of different resolutions.

•	 Tracing Image. Adjusts the document’s background tracing image. You can 
load a new tracing image, make a current one visible, or adjust its position.

•	 Plugins. Lets you “play” browser plug-ins within the document window to test 
embedded media. You can choose to play a document’s plug-ins one at a time or 
all at once, to simulate how a page will look to your viewers.
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•	 Display External Files. You can insert images and other files from your own or 
other websites on the Internet. When you insert an image from another site, you 
can type in or paste an absolute URL (page xx). Dreamweaver even displays the 
image in Design view, but only if you check this option. Because this feature re-
quires an Internet connection to display the image, pages with links to external 
files may take longer to display in Dreamweaver (since it has to get the images 
and files over the Web). If you have lots of external images and files and your 
pages open sluggishly in Dreamweaver, uncheck this option.

•	 Color Icons. Dreamweaver’s interface underwent an overhaul in CS4—the 
once-bright icons were made hip, dull, and gray. They’re still hip, dull, and gray 
in CS5.5. If you you’d rather have the colorful icons from Dreamweaver CS3, 
turn this option on.

•	 Hide Panels (Show Panels). Hides all open panels. If you’ve already hidden the 
panels, the command says Show Panels instead; it restores the panels to their 
original positions.

•	 Toolbars. Displays toolbars for use with Dreamweaver. Select Document from 
the submenu to display the Document toolbar at the top of the document win-
dow. It displays the current page’s title and offers common commands, like dis-
play options, file-management options, code-navigation options, and browser 
previews. The Standard toolbar displays common buttons for common com-
mands, such as opening files, closing files, and cutting, copying, and pasting 
content. The Style Rendering toolbar lets you toggle style sheets off and on, like 
the Style Rendering menu described earlier in this section. The Coding toolbar 
appears along the left edge of Code view and provides options for working with 
HTML, JavaScript, CSS, and PHP code, such as wrapping the code in com-
ments, indenting the code, and more. Finally, the Browser Navigation toolbar 
lets you navigate from page to page in a site while you’re in Live View.

•	 Related Files. Lists all external CSS, JavaScript, and server-side programming 
files the current web page uses. Select one and you’ll see the code for that file. 
Better yet, just use the Related Files toolbar that appears in the document win-
dow—it’s much faster.

•	 Related Files Options. Lets you filter the files displayed in the Related Files 
toolbar (page xx). For example, you can hide all server-side includes, display 
just external CSS files, or create a custom filter to show files that match a cer-
tain pattern (like all PHP files that include DB in the file name). You’ll find 
filters most useful for really complicated server-side programs (like WordPress, 
Joomla, or Drupal) that often overwhelm the Related Files toolbar with dozens 
of included PHP files.

•	 Code Navigator. Pops open the Code Navigator window so you can scan all 
CSS rules that apply to the current HTML element (see page xx).

•	 Show Spry Tooltips. Shows or hides Spry tooltips when you work on a web 
page in Design view (see page xx for more on Spry tooltips).
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Insert Menu
The Insert menu adds selected page elements to a document at the insertion point 
(the cursor’s current position). The commands listed here correspond to the buttons 
on the Objects panel:

•	 Tag. Opens the Tag Chooser window, which provides access to all tags—not 
just HTML tags, but any tag in Dreamweaver’s Tag Library (see entry under the 
Edit menu in “Edit Menu”). You can insert any tag and set any of its properties 
from this window. However, Dreamweaver doesn’t make sure you insert the tag 
correctly, so you should understand HTML (or the tag language you’re using) 
before trying this option.

•	 Image. Inserts an image file, such as a JPG, PNG, or GIF, into the current docu-
ment. The Select Image Source window appears so you can navigate to the file 
on your hard drive. You can choose to make the URL for the file relative to 
either the document or to the site root folder.

•	 Image Objects. Lets you insert placeholder graphics, rollover images, or HTML 
from Fireworks. You’ll see these options discussed on page xx.

•	 Media. Inserts other types of media files, including Flash, Shockwave, genera-
tor applets, plug-ins, and Active X files. In most cases, the standard Select File 
window appears, which you can use to navigate to the desired file.

•	 Media Queries. Opens the Media Queries window and lets you assign different 
style sheets based on the width of a browser’s screen. Useful for building sites 
whose design adapts to a smaller screen, like the one on a mobile phone.  See 
page xx for more on Media Queries.

•	 Table. Inserts a new table into a document. The Insert Table dialog box appears, 
and lets you format the table by specifying the number of rows and columns; the 
table width; measurements for cell padding, cell spacing, and the table border; 
and whether or not and where to include table headers.

•	 Table Objects. Provides a way to insert tabular data (see “Import” in the File 
menu section on page xx) and add other table-related tags such as the <th>—
table header—tag into a page. The tag options in this menu assume you under-
stand HTML and let you just insert the tags without making sure you’re doing 
it correctly.

•	 Layout Objects. Lets you insert absolutely positioned divs and regular divs. This 
menu also includes Dreamweaver’s new Spry Widgets, like the Spry Navigation 
Bar discussed in Chapter 5, and the Spry panel widgets discussed in Chapter 14.

•	 Form. Inserts Form Objects—the <form> tag, text fields, buttons, checkboxes, or 
lists—into a document. (If you haven’t already inserted the <form> tag, Dream-
weaver prompts you to do so.)
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•	 Hyperlink. Inserts a link. The Insert Hyperlink dialog box lets you specify the 
text for the link, the link’s address, as well as many other link options, such as 
the target window and tab index.

•	 Email Link. Creates a new email link at the insertion point. The Insert Email 
Link dialog box appears; you specify both the email address and the link’s text 
(such as “Click to email me”).

•	 Named Anchor. Inserts a named anchor so you can add links to specific posi-
tions within a page. See page xx.

•	 Date. Inserts the current date into a document. The Insert Date dialog box lets 
you format the appearance of the day of the week, the date, and the time. You 
can also automatically update the date each time you save the document.

•	 Server-Side Include. Opens a Find File window, from which you select a file 
that dynamically adds content to your page. Works only with special server set-
ups, such as the dynamic server-driven pages discussed in Part Six of this book.

•	 Comment. Inserts an HTML comment into your page. Web browsers don’t dis-
play the comment, but Dreamweaver represents comments as little gold shields 
in Design view. Use comments to leave notes for yourself and colleagues about 
the page. For example, you might add a comment indicating where a member 
of you web design team should put an ad.

•	 HTML. This menu includes lots of specific HTML tags, such as a horizon-
tal rule, frames, text objects (many of which are also available under the Text 
menu), script objects for JavaScript, and head tags that go in the head portion 
of a web page—including meta tags, such as keywords and content descriptions 
that some search engines use.

•	 Template Objects. When you work on template files, this menu lets you insert 
many of Dreamweaver’s template features, such as Optional, Editable, and Re-
peating Regions.

•	 Recent Snippets. Lists the most recently inserted snippets. Select a snippet 
from the list and Dreamweaver inserts it into the document. You’ll see snippets 
discussed in Chapter 20.

•	 Widget. Like the Spry widgets discussed in this book, a widget is a JavaScript-
powered add-on for a page. However, these widgets usually aren’t as nicely in-
tegrated into Dreamweaver as the Spry widgets, and while some widgets come 
from Adobe, third-party programmers write most of them. You download wid-
gets from Adobe.com using Dreamweaver’s Widget Browser, available from the 
Application toolbar. Once you download and install a widget, you can use this 
menu to add it to a page (see page xx).

•	 Spry. Inserts any Dreamweaver Spry object, including the Spry Navigation Bar 
(Chapter 5), Spry Form Validation widgets (Chapter 13), and Spry Data and 
Layout widgets (Chapter 14).
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Modify Menu

•	 jQuery Mobile. Lets you insert code needed to build mobile applications using 
the jQuery Mobile JavaScript library. For example, you can insert a page, or 
specialized user interface elements like a toggle switch. See page xx.

•	 InContext Editing. Lets you insert tags related to Adobe’s InContext Editing 
service. This online commercial service (as in you gotta pay) lets non-web-sav-
vy individuals update specially created web pages. 

•	 Data Objects. Used to insert server behaviors associated with Dreamweaver’s 
dynamic database-driven Website tools—discussed in Part Six of this book.

•	 XSLT Objects (visible only when you work on an XSL file). Inserts various ob-
jects to convert XML data into a browser–readable format. Learn more about 
this feature in Chapter 28.

•	 Customize Favorites. Lets you add your favorite objects from the Insert panel 
into a special “favorites” toolbar, so your most common objects, images, divs, 
roll-overs, tables, and so on are just a click away. See page xx for more.

•	 Get More Objects. Opens the Adobe Exchange website in your desktop brows-
er (outside of Dreamweaver, in other words). You can search for and down-
load extensions and objects to add new features to Dreamweaver. Use the 
Commands➝Manage Extensions command to integrate downloaded exten-
sions into Dreamweaver.

Modify Menu
You use the commands in the Modify menu to adjust the properties of common 
document objects, like links, tables, and layers:

•	 Page Properties. Opens the Page Properties window, where you can specify 
document-wide attributes—such as the page’s title, background and link colors, 
page margins, and a background image—or select a tracing image to use as a 
reference for designing the page.

•	 Template Properties. Opens the Template Properties window, where you can 
modify settings for template features like the visibility of optional regions, the 
properties of editable attributes, and the values of any template expressions you 
create. Available only when you work on template-based pages, as described in 
Chapter 21.

•	 Selection Properties. When you select this item (as indicated by a checkmark 
in the menu), Dreamweaver displays the Property inspector on-screen; you use 
it to edit the current settings of selected page elements. This command is the 
same as choosing Window➝Properties.

•	 CSS Styles. Controls the display of the CSS Styles panel. A checkmark tells you 
the panel is open. This item has the same effect as choosing CSS Styles from the 
Window menu.
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Modify Menu

•	 Media Queries. Opens the Media Queries window (see the Media Queries en-
try under the Insert menu). 

•	 Edit Tag. Opens a dialog box with detailed options for the HTML tag high-
lighted in the current document. This advanced feature is for the true HTML 
geek—it gives you access to all the properties for a specific tag (not just the ones 
Dreamweaver displays in the Property inspector). But skip this option: The Tag 
inspector, which provides a less-intrusive panel with all the same options, is bet-
ter. Choose Window➝Tag Inspector to open it.

•	 Quick Tag Editor. Lets you edit an HTML tag without leaving Design view. 
If you don’t have anything on the page selected, the Quick Tag editor prompts 
you to enter a new HTML tag at the insertion point (by choosing from an al-
phabetical menu). If you have text or an object already selected when you open 
the Quick Tag Editor, the window displays the selection’s HTML tags so you can 
edit them.

•	 Make Link. Turns a highlighted page element (graphic or text) into a link. 
The standard Select File dialog box appears; choose the document you want a 
browser to open when someone clicks the link.

•	 Remove Link. This command is available only when you select a link or have 
the insertion point inside a link. Remove Link deletes hyperlinks by removing 
the <a> tag from the selected text or image.

•	 Open Linked Page. Opens the linked page in a new document window. This 
command is available only when you have a link selected or have the insertion 
point inside a link. (You can, however, hold down the Ctrl key [�] and double-
click a link to open the linked page.)

•	 Link Target. Sets a link’s target window, defining whether a browser opens the 
linked page in the same window or in a new one. You can choose from _blank, 
_parent, _self, or _top targets, or manually define the target in the Set Target dia-
log box. This command is available only when you have a link selected or have 
the insertion point inside a link. (See Chapter 5 for details on links.)

•	 Table. Opens a list of options to modify a selected table. You can adjust the 
number of rows and columns, add row or column spans, or completely clear 
cells’ defined heights and widths (see Chapter 7).

•	 Image. Opens a list of options to modify a selected image, including optimizing 
it in Fireworks or editing it with one of Dreamweaver’s new built-in image-
editing features, such as the Crop, Resample, and Sharpen tools. See page xx 
for more.

•	 Frameset. Offers options to split the current page into frames. Alternatively, 
you can choose the Edit No Frames Content command, which creates alterna-
tive web page content that older browsers, those without frame support, can 
read. You won’t find frames used on the Web very much any more, and profes-
sional web designers stay away from them—they’re an outdated and clunky way 
to format pages.
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Format Menu

•	 Arrange. Lets you change the Z-index (the front-to-back order) of overlapping 
absolutely positioned elements. You can send one absolutely positioned element 
in front of another, send it to the back, and so on. You can also tell Dreamweaver 
to disallow overlapping elements altogether. If you select two or more absolutely 
positioned elements, you can choose from one of this menu’s alignment options 
to align the components, like the tops of the two elements. See Chapter 9 for 
more on absolutely positioned elements.

•	 Convert. Don’t use this menu! Adobe created it to take a table-based layout 
and turn it into a layout using CSS absolute positioning. It doesn’t work well 
at all. Better to recreate your design using the CSS layout techniques described 
in Chapter 9. The reverse option listed here—converting absolutely positioned 
elements to table layout—produces awful HTML and no benefit (unless you’re 
building a “Retro Web Design Circa 1998” website).

•	 Library. Lets you add selected document objects to a site’s Library file (Chapter 
20). You can also update the current document, or multiple documents, to re-
flect any changes you make to a Library object.

•	 Templates. These commands work with Dreamweaver’s—or your own—tem-
plates (see Chapter 21). Using these commands, you can apply a preexisting 
template to the current page, separate the page from its template, or update 
the page to reflect changes you made to its template. If you have a template file 
open, you can create or delete editable regions (remove the template markup, in 
other words) and update all site files based on that template. You can also add 
repeating template regions and editable tag attributes.

Format Menu
The commands in this menu let you format and modify a document’s text:

•	 Indent. Adds one level of indentation to everything within the current block-
level element (paragraph, headline, bulleted list).

•	 Outdent. Removes one level of indentation from everything within the current 
block-level element.

•	 Paragraph Format. Applies a paragraph format, such as Heading 1, Heading 2, 
or preformatted text, to all the text in the current block-level element. You can 
also go to this menu’s submenu and choose “None” to remove the paragraph 
formatting.

•	 Align. Aligns text in the selected paragraph to the left margin, center, or right 
margin of a document. If a paragraph sits inside a table cell or layer, Dream-
weaver aligns it with the left, center, or right of that cell or layer.

•	 List. Turns the selected paragraph into an ordered, unordered, or definition 
list. You can edit the list’s format by selecting the submenu’s Properties option.
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Commands Menu

•	 Font. Lets you choose from a list of common font combinations to apply a font 
set to the selected text. When a visitor’s browser displays that text, it moves 
down the list of assigned fonts until it finds one installed on his computer 
(Chapter 3). You can create your own combination of paragraph fonts by going 
to the submenu and choosing Edit Font List.

•	 Style. Applies predefined text styles—such as bold, italic, or strikethrough—to 
the selected text.

•	 CSS Styles. Lets you create new CSS styles, and then apply them to selected text 
(Chapter 4). You can also choose to attach an existing style sheet to the current 
document, or export the document’s own style sheet so you can use it in other 
sites.

•	 Color. Opens the standard Windows or Mac color-picker dialog box so you 
can apply color to the selected text. Windows: In general, the Property inspec-
tor’s color box is a better way to assign web colors to text. Macintosh: You can 
choose from a variety of color palettes, including CMYK, RGB, HTML (Web 
safe), HSV, and HLS.

Commands Menu
Use the Commands menu to apply advanced features to your Dreamweaver docu-
ment. Some menu items, such as the Record commands, eliminate repetitive tasks; 
others, such as the Clean Up HTML command, fix common problems in a single 
sweep:

•	 Start/Stop Recording. Records a series of actions that you can apply to other 
parts of a document with a click of your mouse (see Chapter 23). When you 
select the Start Recording command, Dreamweaver records each of your ac-
tions until you choose Stop Recording. Note that Dreamweaver retains only one 
recorded command at a time.

•	 Play Recorded Command. Reapplies the most recently recorded command.

•	 Edit Command List. Opens a list of all saved commands. You can rename the 
commands, or delete them permanently.

•	 Get More Commands. Opens the Adobe Exchange for Dreamweaver website 
in a new browser window so you can search for and download new Dream-
weaver extensions and commands. Dreamweaver downloads extensions to your 
Extension Manager (see page xx).

•	 Get AIR Extension. Takes you to Adobe’s website where you can download a 
Dreamweaver extension that lets you use Dreamweaver to create Adobe AIR ap-
plications—desktop-based programs that work (without a web browser) using 
common Web technologies like HTML, JavaScript, and Flash.
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Commands Menu

•	 Manage Extensions. Opens the Extension Manager, a program that lets you 
manage extensions you download from the Adobe Exchange website (page xx). 
The Extension Manager helps you install, delete, and selectively disable exten-
sions.

•	 Check Spelling. Checks the current document for spelling errors (see page xx).

•	 Apply Source Formatting. Lets you apply Dreamweaver’s formatting prefer-
ences to existing HTML documents. (Normally, changes you make to Dream-
weaver’s HTML source formatting, defined in the Preferences window and the 
SourceFormat.txt file, apply only to newly created documents.) 

•	 Apply Source Formatting to Selection. Same as the previous command, “Ap-
ply Source Formatting,” but applies only to selected content. This command lets 
you selectively apply source formatting so you can, for example, make sure that 
Dreamweaver nicely formats a <table> element but leaves the rest of your finely 
crafted HTML alone.

•	 Clean Up HTML/XHTML. Opens a list of options to correct common HTML 
problems, such as empty tags or redundant nested tags. Once you select what 
you want to fix, Dreamweaver applies those changes to the current document, 
and, if requested, provides a log of the number and type of changes it made (see 
Chapter 18).

•	 Clean Up Word HTML. If you import HTML generated by Microsoft Word, 
you often end up with unnecessary or cluttered HTML tags that can affect your 
site’s performance. This command opens a list of options that corrects com-
mon formatting problems in Word’s HTML. Dreamweaver applies the selected 
changes to the document and, if requested, displays a log of the number and 
type of changes it made.

•	 Externalize JavaScript. Lets you take all the JavaScript code in a web page and 
dump it into an external JavaScript file. This can make web pages download 
more quickly and lets you reuse common JavaScript programs throughout your 
site. Page xx discusses this new tool.

•	 Remove FLV Detection. If you used Dreamweaver CS3 to add a Flash Movie, 
and you then delete that Flash movie, this command removes the JavaScript 
code left behind. Again, this only applies if you have old Flash video pages you 
created way back when, with Dreamweaver CS3.

•	 Optimize Image. Opens the selected image in the Image Preview window so 
you can experiment with different compression settings to find the best balance 
between file size and image quality. See “Inserting an Image from Photoshop” 
on page xx.

•	 Sort Table. Sorts the information in a selected table alphabetically or numeri-
cally, in ascending or descending order. You can’t apply this command to tables 
that include rowspans or colspans.
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Site Menu

•	 Attach an XSLT Style sheet. This option, available only when you work on 
XML files, lets you attach an XSL file, which miraculously transforms cryptic 
XML into a beautiful, browser-viewable page. You’ll find this feature discussed 
in Chapter 28.

Site Menu
As its name suggests, the commands in this menu apply to your entire website rather 
than single documents. These commands help keep your site organized, and pro-
mote collaboration between large workgroups:

•	 New Site. Opens the New Site window, where you can set up a site to start work-
ing in Dreamweaver.

•	 Manage Sites. Opens the Manage Sites Panel where you can create, delete, or 
edit site definitions. See Chapter 16.

Note: The next five menu commands let you transfer files between your computer (the local site) and 
a web server (the remote site). These commands, in other words, don’t work unless you first define a 
remote site in the Site Definition window. In addition, you have to download the files you want to work on 
by selecting them in the Site window (see below).

•	 Get. Copies files (those you select in the Site window) from the remote server to 
your local site folder so you can edit them. Note that if you have Dreamweaver’s 
File Check In and Check Out feature active (see Check In and Check Out be-
low), you can’t edit the downloaded files if someone downloaded a copy before 
you did.

•	 Check Out. Copies files (those you select in the Site window) from the remote 
server to your local site, and marks them on the remote server as checked out. 
No one else can make changes to the document until you upload it back onto 
the remote server.

•	 Put. Uploads files (those you select in the Site window) from your local site to 
the remote site. The uploaded files replace the previous version of the docu-
ment.

•	 Check In. Uploads files you checked out from the local site to your remote site, 
and makes them available for others to edit. Once you check a file in, the ver-
sion on your local site becomes read-only (you can open it, but you can’t edit it).

•	 Undo Check Out. Removes the checked-out status of selected files. Dream-
weaver doesn’t upload the file back to the remote server, so any changes you 
made to the local file aren’t transmitted to the server. Your local copy of the file 
becomes read-only.

•	 Show Checked Out By. Lets you see who’s checked out a file.
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Site Menu

•	 Locate in Site. When you select this option while working on a document, it 
opens the Site window and highlights that document in the site’s local folder.

Note: See Chapter 19 for the full scoop on remote sites, local sites, and checking files in and out.

•	 Reports. Opens the Reports window, and lists options for generating new re-
ports (see Chapter 18). Reports can monitor workflow (such as design notes 
and check-out status) and common HTML problems (such as missing Alt text, 
empty tags, untitled documents, and redundant nested tags). You can generate a 
report on an open document, multiple documents, or your entire site.

•	 Site-Specific Code Hints. This option, available only for PHP websites, lets you 
specify how code hints (the tooltips that pop up as you type programming code) 
work. This advanced feature is for serious PHP programmers.

•	 Synchronize Sitewide. Opens the Synchronization window, which lets you 
compare all your local files with all the files on your web server. Use it to make 
sure you transfer all the files you update locally to your web server, or that you 
transfer all the site files on the server to your local site.

•	 Check Links Sitewide. Analyzes the current site for broken links, external links, 
and orphaned pages. Dreamweaver then generates a report of all the problems 
it found. You can fix problematic links directly in the Report window—or click 
the file name to open the errant file in a new document window, with the link 
highlighted and ready to repair.

•	 Change Link Sitewide. Replaces a broken link throughout your site in one step. 
In the Change Link dialog box, you specify the incorrect link; below it, enter 
the correct link. Dreamweaver searches your site, replacing every instance of 
the old link.

•	 Advanced. Provides access to advanced site options, such as the FTP Log—a re-
cord of all FTP file transfer activity; “Recreate Site Cache,” which forces Dream-
weaver to rescan the site’s files and update its cache to reflect any changes to 
the files or links in the site; “Remove Connection Scripts” to remove the script 
files Dreamweaver creates to work with dynamic, database-driven websites; and 
“Deploy Supporting Files” to move necessary programming files to your server 
when you use Dreamweaver’s ASP.NET server model to build dynamic pages. 
(Since Dreamweaver no longer provides the tools to easily build .NET web pag-
es, this last menu option is, uh, useless.)

•	 Mobile Applications. Let’s you configure your system for creating Mobile Ap-
plications for Android and/or iOS (iPhone, iPad, and iPod Touch), as well as 
build the site for the appropriate platform. This very advanced option is new in 
Dreamweaver CS5.5. See the box on page xx for more.
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Window Menu
This menu controls which panels and windows Dreamweaver displays or hides at 
the moment. (A checkmark in the menu denotes open panels.)

•	 Insert. Opens the Insert panel, from which you can insert various types of ob-
jects (such as images, layers, or forms) into your document. The Insert panel 
also contains options to switch between Layout and Standard table views, and 
to add dynamic elements (such as Spry widgets) to your pages.

•	 Properties. Opens the Property inspector, where you can edit the properties for 
a selected object. The options in the Property inspector depend on the selected 
page element.

•	 CSS Styles. Opens the CSS (Cascading Style Sheet) Styles panel, from which 
you can define and edit CSS styles, or apply existing ones to selected text.

•	 AP Elements. Opens the AP Elements panel, which lists all the elements on a 
page you positioned using CSS positioning properties. See Chapter 9 for details.

•	 Multiscreen Preview. Opens the Multiscreen preview window so that you can 
compare a live version of a web page at three different sizes for smartphones, 
tables, and desktop browsers. See page xx.

•	 Business Catalyst. Opens the Business Catalyst panel. You need to sign up for 
Adobe’s business web hosting service (www.businesscatalyst.com) and down-
load and install the Business Catalyst extension for this panel to work. It lets 
you add code so you can work with sites that this commercial ($$$) web-hosting 
company manages.

•	 Databases. Opens the Databases panel so you can work on dynamic websites. 
This panel lets you connect your site to a database, view the structure of the 
database, and even preview data currently stored in the database.

•	 Bindings. Opens the Bindings panel, which lets you create database queries for 
dynamic sites. In addition, the panel displays and lets you add dynamic data to 
a web page.

•	 Server Behaviors. Opens the Server Behaviors panel, the control panel for 
viewing, editing, and adding advanced features to dynamic web pages.

•	 Components. Opens the Components panel, for use with ColdFusion sites. 
This advanced feature lets ColdFusion developers take advantage of prewritten, 
self-contained programs, which makes building complex dynamic sites easier.

•	 Files. Opens the Files panel. From this window, you can open any file, and 
transfer files between your computer and your remote server.

•	 Assets. Opens the Assets panel, which conveniently groups and lists all the as-
sets (such as colors, links, scripts, graphics, library items, and templates) you 
use in your site.
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Window Menu

•	 Snippets. Opens the Snippets panel, which contains snippets of HTML, JavaS-
cript, and other types of programming code. You can create your own snippets 
to save your fingers from retyping code you use often on a site.

•	 Tag Inspector. Opens the Tag inspector panel, which lists all the properties 
available for the currently selected HTML tag. This uber-geek option is like the 
Property inspector on steroids.

•	 Behaviors. Opens the Behaviors panel, which lets you associate behaviors (such 
as swapping images on a mouse rollover, or checking for necessary plug-ins) to 
selected page elements (see Chapter 15).

•	 History. Displays the History panel, a record of all the actions taken in the cur-
rent document.

•	 Frames. Displays the Frames panel so you can select the frames and framesets 
you want to edit.

•	 Code Inspector. Displays the HTML for the current document. You can edit 
the code directly in this window and see  the Design view of the document at the 
same time. It’s often easier just to use Dreamweaver’s “Code and Design” view 
(View➝Code and Design).

•	 Results. Lets you open Dreamweaver’s many site-wide tools, such as the “Find 
and Replace,” Link Checker, and Reports commands. Pick the operation of 
choice from the submenu.

•	 Extensions. This menu lets you tap various online services Adobe offers, such 
as the web page testing service, BrowserLab (page xx); CS Live, a panel that 
displays information about other Adobe products and gives you access to on-
line help and information; CS News and Resources; and to use the “Share this 
screen” command in conjunction with Adobe’s Connect Now service (www.
adobe.com/acom/connectnow).

•	 Workspace Layout. Lets you save the position and size of Dreamweaver’s pan-
els and windows in any arrangement you like.

•	 Hide Panels. Closes all currently open panels. Choosing Show Panels reopens 
only those panels displayed before you selected Hide Panels.

•	 Application Bar (Mac only). Opens and closes the Application bar at the top of 
the screen, just below Dreamweaver’s menu items.

•	 Cascade. By default, when you have multiple documents open, you switch from 
page to page by clicking tabs that appear at the top of the document area. If you 
prefer to have all open documents floating and resizable within the document 
area, this and the next two options let you “undock” the current documents. 
The cascade option resizes each open document and places them one on top of 
the other. Windows folks can re-dock pages by clicking the Maximize button 
on any currently open document. Mac people can select the Combine As Tabs 
option.

book.indb   1149 6/6/11   5:18 PMwww.itbook.store/books/9781449397975

https://itbook.store/books/9781449397975


1150 dreamweaver cs5.5: the missing manual
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•	 Tile Horizontally (Windows Only). Places all open documents one on top of 
the other. The documents don’t float on top of each other; rather, they fill the 
available document area as row upon row of thin, horizontal windows. With 
more than a few documents open, you see so little of each page that it’s difficult 
to work on any one.

•	 Tile Vertically (Windows Only). Just like the previous command, except that 
Dreamweaver positions the documents vertically, like stripes going across the 
screen.

•	 Tile (Mac Only). This has the same effect as Tile Vertically above.

•	 Combine As Tabs (Mac Only). Returns either tiled or cascaded documents (see 
those options above) to the single, unified tab interface.

•	 Next document, Previous document (Mac only). This pair of commands let 
you step through all your open documents, bringing each one front-and-center 
in turn so you can edit them.

•	 List of Currently Open Documents. Lists all the documents currently open at 
the bottom of this menu. Selecting one brings it to the front so you can edit it. 
But with the easy document tabs, why bother?

Help Menu
The Help menu offers useful links and reference documents that give you more in-
formation about using, troubleshooting, and extending Dreamweaver:

•	 Dreamweaver Help. Launches Adobe Community Help in your desktop 
browser, with the Adobe Dreamweaver CS5.5 reference already selected. Nice. 
From here, you can even search the Web for more information on using Dream-
weaver. Really nice.

•	 Spry Framework Help. An online reference to working with and programming 
Spry widgets, like those discussed in Chapter 14. It doesn’t have any informa-
tion on how to use the Spry tools built into Dreamweaver; instead, it gives pro-
gramming-oriented web designers who want to jump into Code view more in-
depth information on Spry coding itself, and expands on Dreamweaver’s Spry 
features.

•	 Get started with Business Catalyst InContext Editing. As of this writing, this 
link takes you to a page on Adobe.com that says Adobe is discontinuing the 
InContext Editing service. D’oh! Presumably, this option will eventually (per-
haps even as you read this) take you to a page describing Adobe’s business web-
hosting service, Business Catalyst (www.businesscatalyst.com).

•	 Omniture. Takes you to the home page for another Adobe company, Omniture, 
which specializes in collecting and analyzing information about your web visi-
tors. (Perhaps the Help menu should be renamed “Help our marketing depart-
ment sell you new services.”).
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Help Menu

•	 ColdFusion Help. Takes you to an online reference to Adobe’s server-side pro-
gramming language, ColdFusion, on Adobe.com.

•	 Reference. Opens the Reference panel, a searchable guide to HTML tags, Cas-
cading Style Sheets, and JavaScript commands. All of the guides are woefully 
out of date, so it’s best to avoid them. The HTML reference, however, still pro-
vides good information on the HTML 4.01 tags you’ll use while building web 
pages in Dreamweaver.

•	 Dreamweaver Support Center. Opens the Community Help section of Adobe’s 
online Dreamweaver Help and Support site, which provides access to tutorials, 
videos, and troubleshooting tips.

•	 Dreamweaver Exchange. Launches your desktop browser and loads the home 
page for Adobe Marketplace & Exchange on Adobe.com. You’ll have to take the 
extra step of clicking the “Dreamweaver” link on the page to find extensions 
that add new features to Dreamweaver (see Chapter 23 for details).

•	 Manage Extensions. Same as the Manage Extensions menu option listed under 
the “Commands” menu (see page xx).

•	 CSS Advisor. Takes you to Adobe’s online CSS advisor. This site provides infor-
mation about common (and not-so-common) CSS bugs. It works in conjunc-
tion with Dreamweaver’s Check Browser Compatibility tool discussed on page 
xx. Unfortunately, the site isn’t well maintained and has failed to keep up with 
problems related to newer browsers.

•	 Adobe Online Forums. Opens an index of available online forums on Adobe’s 
website. You can interact with other Adobe customers, post questions, share 
techniques, or answer questions posted by others. Requires Internet access and 
a newsgroup reader.

•	 Product Registration. In order to use many of Adobe’s online services, such 
as Adobe BrowserLab (page xx) or the Exchange (page xx), you need to sign 
up with Adobe by providing your name, email address, password, city, and Zip 
code. Although some of the online services cost money, creating an Adobe ac-
count is free and you don’t need to give them any credit card information.

•	 Activate. As part of Adobe’s attempt to stop piracy of their software, Dream-
weaver’s Software Activation module contacts Adobe and makes sure that your 
copy of Dreamweaver isn’t activated on anyone else’s computer. Adobe lets you 
install Dreamweaver on one desktop and one laptop of the same operating sys-
tem. If you don’t activate your software, the program stops working after 30 
days.

•	 Deactivate. If you get a new computer, do not forget to deactivate the software 
on your old one. Use this menu option to do so. Deactivating the software lets 
you install it on another computer.

•	 Updates. Launches the Adobe updater. It finds updates for Dreamweaver (and 
every other Adobe product you installed on your computer).
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Help Menu

•	 Adobe Product Improvement Program. Opens a window that lets you par-
ticipate in this Adobe project, which collects information about your use of 
Dreamweaver. According to Adobe, all the information is anonymous. 

•	 About Dreamweaver (Windows only). Opens an About Dreamweaver window, 
showing your software’s version number. (On the Macintosh, you’ll find this 
command in the Dreamweaver menu.)
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